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This diagram illustrates typical steps and processes that can occur within
PDF/X workflows:
nn Image manipulation – media neutral or process specific
nn Vector graphic creation – process specific
nn Layout and design – media neutral or process specific
nn PDF/X export – process specific PDF/X creation
nn PDF/X creation: PDF/X-1a and PDF/X-4 CMYK
nn PDF/X preflight: can be done using a variety of third party software solutions
nn PDF optimization and output
More detailed information about each of these items can be found on the following pages.

www.pdfx-ready.ch
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The PDFX-ready Example Page
The PDFX-ready example page as shown below
is your key to getting the most out of the PDFXready Workflow V2 guideline. It shows the advantages of the PDFX-ready Workflow V2.
You can use the PDFX-ready example page
nn to review the benefits related to the usage of
the PDFX-ready Workflow V2 guidelines.
nn as a guide for reliable creation and processing
of PDF files.
nn to check your workflow settings.

y
PDFX- re a d

You can download the PDFX-ready example
page file at www.pdfx-ready.ch. A detailed description of the different elements contained
within the PDFX-ready example page can be
found in the pertinent chapters of this guide.
Note: This test page does not replace the PDFXready certification. It also does not replace the
test pages provided from PDFX-ready and other
organizations. It is an additional tool for testing
and demonstration purposes.
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The PDFX-ready guideline is meant to assist
both content creators and output producers to
successfully create print ready PDF/X data:
nn Content Creator: creates the document
layout and exports a print ready PDF/X document.
nn Output Producer: receives, checks and consumes and executes PDF/X files for the intended output .
As you progress through this guideline, you will
see a yellow box on the top left side of relevant
pages. The text within this yellow box indicates
the intended audience (content creator or output
producer) and which workflow step is being discussed. Similarly, information about upcoming
processes can be found in a yellow box in the
bottom right corner of relevant pages.
This guide uses the following symbols:
A green check mark indicates that the
result is OK.
A red “X” represents an error or a
significant problem.
Warnings are marked by the yellow exclamation mark. Here you need to decide if this may or may not lead to problems depending on the situation.
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PDF Processing – yesterday, today and tomorrow
As the printing and publishing industry has
changed so has the way PDF files are handled.
The multichannel publishing paradigm is replacing the conventional way of data preparation
designated for a specific printing condition. This
evolution is evident in changing publishing processes that strive for media neutrality, making
cross media data preparation essential.

RGB
Raster

CMYK Layout
Sheetfed offset coated
CMYK Layout
Sheetfed offset un coated
CMYK Layout
Newspaper

Over the last decade PDF has become the standard file format for prepress workflows. Most
current RIP technologies now ship with native
PDF rendering capabilities, and no longer rely
on PostScript as the RIPping engine. The PDFXready V2 Workflow guideline no longer relies on
PostScript, but instead utilizes the native PDF
rendering capabilities of current prepress RIPs.
By utilizing native handling of PDF objects,
significant benefits can be gained that are not
possible with PostScript. Many of these benefits
will be described in this guideline.
Media neutral image storage and archiving is
now standard practice for the much of the industry. PDFX-ready V2 recognizes this practice
and recommends to keep images in RGB and not
to separate/convert raster images for a specific
printing condition.

CMYK Layout
Web offset

PDFX-ready V1

Future versions of PDFX-ready will explore
the concept of media neutral documents instead of just media neutral images. Modern
output channels such as tablets require that both
vector and raster data is represented in RGB, requiring the need for media neutral documents.
PDFX-ready is committed in its efforts to adapt
these guidelines for advanced PDF production of
our changing media and publishing world today,
and in the future.

PDF/X-1a CMYK
Sheetfed coated
Output condition:
CMYK

Processing using
PostScript (CPSI) RIP

optional
PDF
correction
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PDFX-ready V2

PDF/X-4 CMYK
Sheetfed coated
Output condition:
CMYK

CMYK
Raster
Text/Vector
A
CMYK

Exclusive native PDF RIP processing

Future?

PDF/X-4 RGB
media neutral
Output condition:
RGB/CMYK

RGB
Raster
Text/Vector
A RGB

Native PDF processing and
output specific rendering

optional
PDF
correction
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> BASICS > PDF FILE FORMAT
PDF/X STANDARD

PDF and PDF/X
By introducing the Acrobat software family and
the PDF file format, Adobe successfully developed a universal platform independent mechanism that enables electronic documents to be
viewed and printed almost anywhere.
Since 1993 PDF has become the de facto standard for the electronic exchange of documents.
The free Adobe Reader software has been distributed around the world, facilitating efficient
reading and printing of digital content.
Although originally designed for office use, PDF
has, over time, replaced native application files
and PostScript as the preferred file formats of
most printing companies. Today, PDF is the de
facto standard for the exchange of print ready
files.

PDF/X-4:2008 vs. 2010
The names of the Adobe PDF Export settings include a year that
corresponds to the publishing
date of the relevant parts of the
ISO 15930 standard. In the case
of PDF/X-1a and PDF/X-3 there
are indeed two different specifications which are both valid.
In the case of PDF/X-4, however,
there is only one valid specification of the ISO standard. The original PDF/X-4 standard was published in 2008, hence the name
PDF/X-4:2008.
In 2010, the standard was revised,
namely to change the definition of
optional content and remove ambiguities. Hence PDF/X-4:2010 is
a revision of PDF/X-4:2008.
There is only one valid PDF/X-4
standard.

PDF/X ISO Standards for Print
The PDF file format can incorporate non printable elements such as video or audio objects.
While this is important for digital media applications, it can be problematic when using PDF for
high quality printing in the graphic arts industry.
For this reason PDF files created for commercial
print applications must be restricted to print-only
elements.
In order to provide predictability and consistency
in PDF files created for the graphic arts industry,
the multipart ISO 15930 standard was developed. The individual parts of the ISO standard
reflect the different “flavours” of “PDF/X-Standards” (PDF/X-1a, PDF/X-3, PDF/X-4, etc.).
From the current 8 “flavours” of PDF/X standards, two of them best reflect the current needs
of the industry:
nn PDF/X-1a for traditional print workflows using
CMYK and spot colours.
nn PDF/X-4 for modern workflows using live
transparencies, supporting colour managed
objects, CMYK and spot colours.
PDFX-ready provides guidelines for
both PDF/X-1a and PDF/X-4 workflows.
PDF/X-4 replaces PDF/X-3, which was historically recommended by different trade organizations
in german speaking countries. Since PDF/X-3
does not support live transparencies, a flattening
process is needed, which inhibits the ability for a
media neutral workflow.
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The “X” in PDF/X stands for “blind eXchange”
and represents the reliable and predicable exchange of content rich PDF documents.
PDF/X documents better suit the needs for data
exchange of print ready documents such as ads
than regular PDF documents. PDF/X files contain
important features such as embedded fonts, information about the bleed and trim format and
the intended printing process as well as the trapping status.
PDF/X Plus
However the PDF/X standard does not define
quality criteria like the minimum resolution.
These criterias depend from the the printing
process, the paper and the quality expectations
and can therefore not be part of an general ISO
standard. It was decided to leave the definition
of additional quality criteria to other organisations
like the Ghent Workgroup (www.gwg.org).
These additional restrictions, combined with
PDF/X standards, is referred to as PDF/X Plus
soecifications.
PDF/X Plus further restricts the PDF/X standards
for different print applications (e.g. shedfed offset, newspaper) to cover the following aspects:
nn Minimal resolution,
nn Total ink coverage (TVS, tone value sum),
nn Minimal thickness of lines (hairlines),
nn Overprinting,
nn Number of spot colours,
nn Correct Output Intent
nn And more
In simple terms: PDF/X contains the general requirements for all printed products. PDF/X Plus
adds additional restrictions for specific printing
applications.
PDF/X Plus is at the core of the PDFX-ready idea.
Based on the work done by the Ghent Workgroup, PDFX-ready defines settings and preflight
profiles that allow for both the correct creation
as well as indepth checking of PDF/X Plus documents.
The figure on page 9 shows the increasing restrictions of the PDF file format in order to get
good print ready files.

PDF restrictions needed for prepress data creation

Company or client requirements

PDF/X-4

Sheet Fed,
Offset
Classic HQ

Sheet Fed,
Offset
CMYK V2

Web offset
Classic HQ

Web offset
CMYK V2

Newspaper
Classic HQ

Newspaper
CMYK V2

Ghent PDF Workgroup (GWG) specifications

more restrictive

PDF/X-1a

PDF/X-1a
PDF/X-4
PDF/X Standards
Restricted PDF features
General requirements for the all files to be “printed”
PDF/X Metadata

PDF Specifications
Full functionality

www.pdfx-ready.ch

> NEXT:
SELECT THE RIGHT PDFX-READY STANDARD, PAGE 10
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CREATOR > PDFX-READY STANDARDS

Which PDFX-ready standard should you pick?
PDFX-ready offers two different workflows:
V1.3 and V2. The V1.3 workflow is based on a
more traditional PDF/X-1a model, while V2 uses
PDF/X-4 and therefore allows for more variability in PDF creation and processing such as live
transparency.
The PDFX-ready workflows are guidelines for
validating PDF documents. Although PDFXready provides settings and recommendations
for the creation of layouts (InDesign, Quark
XPress), there are many different ways to create and export a document that can result in a
“good” PDF. What counts is how well the final
PDF measures against the PDFX-ready preflight
rules associated with the corresponding end use
of the PDF.

“My output partner is using a
PostScript RIP or a RIP that can
only process flattened PDF documents. My output partner explicitly requires PDF documents with
flattened transparencies”

With two PDFX-ready workflows how can we
know which is the right one to use? Simply stated, it depends on the level of sophistication of the
document, and the type of equipment used by
your print service provider/output partner.

PDFX-ready V1.3
PDF/X-Workflow: PDF/X-1a:2001
PDF-Version: 1.3

Classic
Flattened Transparency
CMYK + Spot Colour(s)

10

Creator
“How is my output partner equipped?”
“I don’t know my output partner or their
equipment specifications. I am comfortable using either PDFX-ready V1.3 Classic
or PDFX-ready V2 CMYK.”

“My output partner uses modern
equipment and I would like to
exchange state of the art data.”

– Recommen

dation –

PDFX-ready V2
PDF/X-Workflow: PDF/X-4:2010
PDF-Version: 1.6

CMYK
Live Transparency
CMYK + Spot Colour(s)

Output
> NEXT: PREPARING IMAGES
PROCESS SPECIFIC (PAGE 12) AND/OR MEDIA NEUTRAL (PAGE 13)

www.pdfx-ready.ch
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> CREATOR > CMYK > V1.3 > IMAGES > PROCESS SPECIFIC
V2

Edit/Retouch

Process specific image preparation

1 PDFX-ready offers Adobe colour settings. You
can download the csf files at www.pdfx-ready.ch.
You can also use these files to synchronize the colour
settings of all CS applications by using Adobe Bridge.

2 In order to prepare images for a specific printing
condition it is recommended to do the retouching on
a calibrated and profiled monitor in RGB colour space.
3 To avoid unexpected surprises when the im-

12

Convert

4 After finishing the retouching the conversion
to CMYK can be applied. It is recommended that
you use Edit -> Convert to Profile in order to
find the best settings. While the recommended
ICC profiles often result in satisfactory separations, different profiles (representing the same
printing condition) might also be used.

Save

age is converted to CMYK, you can simulate the final
appearance by using the softproof (Proof Setup) of
Photoshop. Simply go to View -> Proof Setup ->
CMYK-Working Space for the selected output
condition or Custom for individual settings.

5 Save the final CMYK image by using one of the
typical file formats (TIFF, PSD or JPG). Please always
include the used ICC profile when saving the image file.
When preparing images in a process specific way, each
printing condition will require a separate image that has
been prepared for the intended output. It is recommended to store the original RGB image file as the basis
for additional separations. If you have to prepare data
for different output processes this
method results in the creation of
multiple image files which increases
the risk for potential errors. A more
flexible alternative option is to
let the layout application do the
RGB-CMYK conversion (see page
24), or to use a tailored CMYKCMYK devicelink transformation
(see page 48).

> CREATOR > CMYK > V1.3 > IMAGES > MEDIA NEUTRAL
V2

Media neutral image preparation

– Recommen

dation –
Black Point Compensation

This method is based on a relative colorimetric
rendering intent with black point compensation. This is the recommendation for all output
intents except for ISOnewspaper26v4 where
a perceptual rendering intent without black
point compensation is recommended.

Normalize

In addition to the “Relative Colorimetric” rendering intent, black
point compensation (bpc) allows
for better shadow details. For the
“Perceptual” rendering intent,
bpc has (mostly) no effect.

1 PDFX-ready offers Adobe colour settings. You
can download the csf files at www.pdfx-ready.ch.
You can also use these files to synchronize the colour
settings of all CS applications by using Adobe Bridge.

Background: Black point compensation is a method developed by
Adobe and available in Adobe applications. It must be noted that
this transformation is not fully
specified; therefore, different implementations may end up with
slightly different results.

2 In some situations it is recommended to convert the RGB source space to a well defined RGB
working space. PDFX-ready recommends the
eciRGBv2 working space. Please select Edit ->
Convert to Profile, to do the conversion as shown.

profiled monitor in RGB colour space. To simulate
the result of a conversion to a specific printing condition, you can initiate the soft-proof preview by clicking
View -> Proof Setup -> Custom. This allows you to
preview how critical (e.g. saturated) colours will be
later separated. PDFX-ready recommends to use the
CMYK working space “ISO Coated V2 300% (ECI)”.

Edit/Retouch

3 Retouching should be done on a calibrated and

file formats (TIFF, PSD older JPG). Please always include
the RGB profile. This image now serves as a master
both for print (offset printing on coated or uncoated
paper, newspaper printing etc.) and non-print (e.g. Web,
Tablet). This media neutral form of image archiving is
fundamental for current and future multichannel publishing workflows. Conversion to the intended CMYK colour
space for print will be done either by the layout application (see page 24) or by the PDF workflow of the sender
or receiver (see page 44).

Save

4 Save the final RGB file by using one of the typical

www.pdfx-ready.ch
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> CREATOR > CMYK > V1.3 > GRAPHICS > PROCESS SPECIFIC
V2

Process specific preparation of vector graphics

1 PDFX-ready provides Adobe colour settings. You

can download the csf files at www.pdfx-ready.ch.
You can also use these files to synchronize the colour
settings of all CS applications by using Adobe Bridge.

2 Prepare any linework/vector art in Adobe Il-

lustrator in the CMYK colour mode. Please take
note of the suggestions in the logo on the right.

Please use appropriate CMYK values when defining colours. Don’t use RGB values since Illustrator will immediately convert these to
CMYK with sometimes silly values.

Illustrator
converts it to:

3 Save the file as an Adobe Illustrator file
(AI format).
Avoid saving files as EPS-files, since they are outdated and do not support live transparencies.

14

Prepare spot colours as such (not as process colours).

Always use the gradient tool within Illustrator for
opaque and transparent vignettes. This will ensure for
a high print quality at the output side.

Black and grey tones should always be defined as
pure black, i.e. only “K”. Black objects defined as
RGB always result in an unwanted 4 colour grey.

Overprint Preview
Illustrator
converts it to:

As long as you save your files in the AI format, transparent
objects, drop shadows or transparent gradients should
reproduce with good results on press. Using EPS files
where a flattening process is required is not recommended because native transparencies must be rendered.

Adobe InDesign, Illus
trator and
Acrobat offer an overprint preview feature. This allows you to
visualize how the document will
look when the present overprint
settings are honoured. Overprint
preview can be accessed by clicking on View -> Overprint Preview.

Please note the correct
overprint settings.
www.pdfx-ready.ch

> NEXT: CONFIGURING LAYOUT APPLICATIONS (PAGE 16)
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> CREATOR > CMYK > V1.3 > LAYOUT > SETUP
V2

Configuring layout applications – New documents

PDF/X Output Intent
All PDF/X files contain an Output
Intent. The Output Intent indicates for which printing condition
the objects in device colour (without an attached ICC profile) in the
document have been prepared
for.
The Output Intent must be selected when creating the PDF file.

Using images with tagged ICC profiles is not
a new concept, however it is sometimes not
known that layout documents are tagged with a
profile. Modern layout applications require two
profiles: one for CMYK and one for RGB. Both
profiles will be used as working spaces for newly
created documents. They are defined in the basic colour settings. So what are the implications
of this for CMYK based print workflows?
nn The RGB profile will be used when RGB objects without an attached ICC profile are used
(DeviceRGB). This scenario should not occur
often in files created by professionals. Therefore the choice of the RGB working space is not
that important.
nn The CMYK profile defines the source and
destination colour space for all placed CMYK
elements (DeviceCMYK), assuming the PDFXready colour settings are used. The colour
settings for InDesign are shown below while
the QuarkXPress settings can be found on
the next page. These settings require that all
imported CMYK elements (both images
and artwork) must be prepared for the intended printing condition represented by
the CMYK profile. CMYK objects with tagged
ICC source profiles will be handled according
to the PDFX-ready specs as DeviceCMYK. Images prepared for different printing conditions

must be converted to the intended printing
condition before placing them in the layout.
By doing this, unwanted CMYK-CMYK colour
transformations can be avoided.
The PDFX-ready export settings for InDesign
honour the document CMYK working space.
This allows for a generic PDF export setting for
all kinds of output conditions since the destination profile (Output Intent) will be defined by the
document colour space. In case of CMYK based
output, all RGB based elements will be converted to the CMYK output intent during the PDF
export.
The combination of setting the correct document
colour setting combined with the right export
settings stresses the importance of consistent
colour handling throughout the workflow.
Note that QuarkXPress offers no link between
document setup and the PDF export, therefore it
is extremely important to select the PDF output
style that matches the present document setup
as well as the prepared data to be used. 

InDesign
(CS4 and newer)

PDFX-ready provides Adobe colour
settings. You can download the csf
files at www.pdfx-ready.ch. You can
also use these files to synchronize the
colour settings all CS applications by
using Adobe Bridge.
These colour settings represent
the basic settings that should be
used for all new documents.

16

QuarkXPress (version 9 and newer)

PDFX-ready provides source setups for
QuarkXPress for version 9 and newer. You
can download the files at www.pdfx-ready.ch.
These settings will be imported by means of a
“mother document” to be followed by applying them in the Source Setup window. Details
can be found on the PDFX-ready website.
The basic colour settings will be defined based
on the source setup. They form the basis for
all new documents for both RGB and CMYK
elements.
www.pdfx-ready.ch
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> CREATOR > CMYK > V1.3 > LAYOUT > SETUP
V2

Configuring layout applications – Existing documents
Assuming the PDFX-ready colour settings are
applied correctly, they will become the default
settings for all new documents.
For existing documents that did not have the PDFXready colour settings defined as the default, oth-

er default rules apply. In this case, the profiles
stored within the document will likely be used.
In order to avoid this, manual intervention is required to edit the existing settings to achieve the
same result as when the PDFX-ready settings
are used.


InDesign CS4
and newer

Recommended
rendering intents
PDFX-ready recommends using
a relative colorimetric rendering
intent with black point compensation for all output intents except
for ISOnewspaper26v4 where a
perceptual rendering intent without black point compensation is
recommended.

Open the existing document and
click on Edit -> Assign Profiles....
Here you have to change the
RGB and the CMYK profiles to
the PDFX-ready working spaces.
This leads to an adjustment of
the document colour settings.
You must also take care to
ensure placed elements also
represent the newly assigned
profiles or printing conditions,
otherwise wrong results are
likely. This step is particularly
important for InDesign since
the document CMYK colour
space (working space) will
be used for the PDF export.
All colour settings for imported
This screenshot shows the colour settings for creating a document
illustrations, CMYK images includdesignated for newspaper printing using the perceptual rendering
ing the InDesign setup must be
intent recommended by IFRA.
consistent in order to get a PDF
which not only has the correct output intent but also the corresponding colour data. Beside the ICC profile we
also recommend to embed the rendering intent into the document in order to guarantee that this rendering intent
will be used during the conversion of RGB to CMYK and not the rendering intent defined in the application preferences.

QuarkXPress
version 9

In QuarkXPress you must alter the settings
defined in the source setup by clicking QuarkXPress -> Preferences -> Print Layout -> Colour
Manager. The “Source Setup” must be changed
to the appropriate PDFX-ready Output Style
(these must be installed beforehand). Like in
InDesign, it is very important that the placed
vector and bitmap elements are colour managed
for the intended output conditions.

18

Live Preflight in InDesign
PDFX-ready also provides profiles for the Live
Preflight tool in InDesign. This allows a preliminary check of document conformance at the layout and design stage. The PDFX-ready profiles
ensure that the most important aspects of your
document are correct and consistent.
InDesign’s Preflight tool does NOT replace the
preflight check of the final PDF! Don’t forget to
check your PDF files with the PDFX-ready preflight profiles in Acrobat after they are created.
Due to the somewhat restricted functionality of
the InDesign preflight, the results can’t be compared to the full-featured capabilities of more
complete preflight tools. Instead, InDesign’s
preflight tools can be thought of providing
useful but limited information during the layout phase that can help you to detect many
problems fast, and before the PDF is created.
InDesign’s preflight tool cannot distinguish between errors and warnings. Every finding is an
error. This can result in some errors being reported that really are not errors at all. Not all errors
reported by InDesign Live Preflight will result
print problems. Many reported errors may just
be informative or a precautionary warning, and
therefore each reported error should undergo an
individual, job specific assessment.

The PDFX-ready InDesign Preflight profiles
can be imported and activated via the Preflight window.

At the bottom of the layout window the number of
errors in the document are displayed in real time.

Keep in mind that additional problems might occur as a result of exporting the PDF since the
PDF setting may include flattening, downsampling or colour conversions that might alter the
intended appearance. Carefully check the final
PDF for accuracy.
You can download the InDesign Live Preflight
profiles together with installation instructions at
www.pdfx-ready.ch. 

Preflight results are reported in the
Preflight Panel, along with an explanation in the info section . A double click
selects the error in the document.

> NEXT: DESIGN A LAYOUT
PROCESS SPECIFIC AND/OR MEDIA NEUTRAL (PAGE 20)

www.pdfx-ready.ch
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> CREATOR > CMYK > V1.3 > LAYOUT > DESIGN
V2

Design a layout
There are two different approaches regarding the
images in a layout:

dation

– Recommen

nn Process specific (optimized or prepared
for a given printing conditions): All images
must be converted to the CMYK defined in the
output intent. At the same time this printing
condition reflects the document CMYK colour
space (see page 16).
nn Media neutral (not optimized or prepared
for a specific printing (output) condition):
Images are not yet colour converted, i.e. stay
RGB. These RGB images will be placed in the
– layout, and the layout application is responsible
for the colour conversion to CMYK.
All other print elements shall be prepared in
CMYK. Always use the CMYK values that fit the
intended output condition. Workflows that use
media neutral (RGB) graphics are currently considered too risky and not practical. The layout
document itself is therefore always process
or media specific.

What are optimal values?
The question as to what extent
a CMYK value is appropriate for
a given printing process basically
depends on the used screening as
well as the colorimetric and print
related properties of the printing
process. Typical examples are the
registration accuracy, the tonal
range which can be reproduced
by the printing process, the size of
the hairlines, smallest reproducible dots, screening frequency,
and the maximum total area coverage (TAC).
In cases where these properties
are properly defined when preparing print documents, the resulting
tone values are “optimal values”.
Typical recommendations include:
nn To only use K for black text
nn To avoid tone values below
approx. 10% (since they might
not be reproduced in a reliable
fashion).
nn To select a black generation
strategy (UCR/GCR) that uses
more black and less CMY
to define neutrals, which
can result in more consistency across the print run (e.g.
CMYK=0,0,0,50 instead of
CMYK=45, 36, 36, 0).

The layout on the right contains examples for
both of the above mentioned strategies.

Use optimal CMYK values (incl. blacks and greys)
for all linework objects. Do not use RGB values
– the resulting CMYK values will be based on generic conversions and will be far from optimal!

Define spot colours correctly as such in the layout
program.

Place all vector graphics as CMYK objects (+ spot
colours) as described on page 14.

Resulting
conversion

20

Attention!
Problems with Pantone colours
in Adobe CS6 and CC

Placed images should be either:
nn process specific, as described on page 12, with
CMYK colours for the selected output process.

nn or media neutral by using RGB, as described on
page 13. The conversion to the appropriate CMYK
profile will be done while exporting the PDF with
the layout application.

Starting with Creative Suite 6
Adobe is shipping the PANTONE+
colour libraries. Those contain
LAB colour definitions which give
a better simulation of the spot colours on monitors. However these
new colour definitions produce
completely different results for
some colours when these colours
are converted to process colours
than the old PANTONE colour libraries which contained CMYK
colour definitions.
On the know how page of the
PDFX-ready website one can find
a workaround to re-install the old
PANTONE libraries in Adobe InDesign and Illustrator CS6 and
CC:
http://www.pdfx-ready.ch/index.
php?show=538 (german only)

– Recommen

dation –

> NEXT: OPTIMIZE LAYOUT (PAGE 22)

www.pdfx-ready.ch
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> CREATOR > CMYK > V1.3 > LAYOUT > OPTIMIZE
V2

Optimize layouts with transparencies
2

1

Text with shadow

Text with shadow

Text in the
foreground

In cases where it is not possible to use live transparencies you can use the PDFX-ready V1.3Workflow. However , PDFX-ready recommends
that you optimize the layout before flattening the
transparent objects to ensure the best possible
flattening result.
Layout optimization is also good practice when
using the PDFX-ready V2 workflow. The quality
of the resulting PDF documents will be increased
while the PDFs will be less prone to processing
errors downstream.
Adjust object stacking 1
The rules for reducing (flattening) transparency
is the same in QuarkXpress as they are in Adobe
InDesign. Transparency is always reduced from
the foreground to the background, and consequently the stacking sequence of overlapping objects is very important. In order to avoid unnecessary transformations (e.g. of vectors or text to
images), nontransparent (opaque) objects should
be brought to the front of transparent objects
(see text and check mark in example above). The
use of layers might be helpful in separating objects with and without transparency and checking for the right stacking order.
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Text displacer sandwiches
A common layout scenario involves ankering an
image with a drop shadow into the text flow. In
order to optimize this scenario for transparency
flattening you might want to build a “sandwich”:
On the bottom of the sandwich is an empty
frame with the drop shadow. The next layer of
the sandwich is the text and the top of the sandwich is image frame with the image placed. The
end result looks the same but the text will not be
rasterized or converted to vector as part of the
transparency flattening.
Avoid overlapping frames 2
In many instances the flattening process is governed not by the content of the frame but by the
frame itself! Therefore flattening can cause issues with objects although they do not visually
overlap or touch any transparent objects. Avoid
overlapping frames whenever possible and define the frames as small as possible.
By implementing both techniques – adjusting
object stacking and avoiding overlapping frames
– you can prevent many of the problems that are
related to the flattening of live transparencies.

w

Shadow 100% K
CMYK

causes conversion

RGB
Transparency and colour management 3
With the advent of transparencies, colour management has to deal with an additional dimension: There are mixed colour constellations created by overlapping elements encoded in different
colour spaces that must be resolved. A good
example is an RGB image that is overlapped by
a CMYK based drop shadow. For the overlapping
area a decision must be made: Is the colour that
results from the blending of the two objects RGB
or CMYK?
The decision is governed by the transparency
blend space. In InDesign the chosen blend space
affects the entire page while in QuarkXPress only
those objects are involved which are part of this
particular transparency group.

Even in cases where there is no flattening (and
the final PDF is version 1.4 or higher), the definition of the transparency blend space is till an
important consideration for later flattening processes or colour conversions.
Spot colours and transparency
Layouts using transparencies should only use spot
colours when they are really required as a separate
colour to be printed. Since flattened spot colours
can’t be converted to CMYK anymore these conversions should be done in the layout before exporting the PDF. PDF documents with live transparency
clearly benefit here since the possibility of a spot to
process colour conversion later in the workflow is
maintained. 

In InDesign you can select the transparency blend space by clicking Edit -> Transparency Blend Space and choose either
Document
CMYK
or
Document
RGB.
PDFX-ready recommends to always select Document CMYK. In QuarkXPress the blend space
will be defined by the PDF output style. All
PDFX-ready settings always use a CMYK blend
space.
www.pdfx-ready.ch

> NEXT: LAYOUT-OUTPUT STRATEGIES(PAGE 24)
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Colour Management: Early vs. Intermediate Binding
The term “Binding” is related to the stage in the
workflow where the data conversion RGB to the
intended printing condition happens. With respect to the typical graphic arts workflow there
are 3 possible stages for binding:

To convert images already in the image edition
software is considered to be the most conservative approach. Although you have full control of
the separation, you will need different images for
each individual printing condition.

nn Early Binding
nn Intermediate Binding
nn Late Binding

In most cases you can use these default settings
for the conversion to CMYK:

The following guidelines are specific to pixel
based images (i.e. raster data) because usually
only pixel images are converted from RGB to
CMYK.
Early Binding
Raster images are converted to CMYK in an image editing software such as Adobe Photoshop.
The user has full control of the conversion. This
is generally determined by the destination profile, the rendering intent and black point compensation.

PDFX-ready recommends to use Intermediate
Binding. By doing so, you can use one image
file that serves as a master. This helps to reduce errors - in particular those related to using the wrong version of an image.

Intermediate Binding
The images are retouched and remain in RGB.
These RGB images are then placed in a layout.
When a print quality PDF is exported, all images
are converted to the output condition. The user
controls the conversion by means of the basic
application settings, document colour settings,
as well as the PDF export settings used.

nn Correction (Retouching) is required in CYMK
nn Conversion must be done with different settings
nn A destination profile is used that performs a
dedicated black generation or (separation in
general) while reflecting the same underlying
printing condition. This is typically the case
for Microsoft Excel charts or textile reproductions.

Late Binding
RGB images are exported into the PDF including the embedded source profile. The conversion to the destination colour space is only done
during output using the colour management settings of the output workflow. PDFX-ready does
currently not recommend using late binding since the resulting colour is not entirely
predictable because of different vendor and
application specific interpretations for the
rendering of transparencies using ICC based
colours.
Process specific data exchange
Both PDFX-ready V1.3 and V2 CMYK workflows
are designated as process specific ways of data
exchange. This is because the content is already
fully prepared for the output intent. The PDF document only contains print elements encoded
as CMYK, gray or spot colour. This means RGB
images are either converted to CMYK at the PDF
export from the layout application (Intermediate
Binding) or are already available in the CMYK of
the output intent (Early Binding).
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nn Relative colourimetric rendering intent
nn Use blackpoint compensation
nn Embed the source (RGB) profile
nn Make sure the right destination profile is selected or used by default.

Early Binding should be used when:

When using Intermediate Binding care must be
taken to apply the correct colour settings, document colour settings and PDF export settings.
Intermediate Binding has the advantage that
RGB images will always be converted to the correct output profile. In addition there is no need to
store and maintain multiple versions of images
for different output conditions. Using intermediate binding allows for changing of the output
intent at the PDF creation stage when needed.
However, keep in mind that linework must be
re-separated since it is prepared for one specific
printing condition.

dation –

– Recommen

Early Binding

Intermediate Binding

Late Binding

Photoshop – Image editing in RGB

Photoshop –
Conversion
to CMYK

Photoshop –
Save as RGB image

Layout – Document design

Images – CMYK,
Layout – CMYK

Images – RGB,
Layout – CMYK

Images – RGB,
Layout – CMYK

PDF export –
1:1

PDF export –
Conversion
to CMYK

PDF export –
1:1

PDF/X file

Image – CMYK,
Layout – CMYK

PDF output

Images – CMYK,
Layout – CMYK

Images – RGB,
Layout – CMYK

PDF output

PDF output –
Conversion
to CMYK

www.pdfx-ready.ch

> NEXT: PDF-EXPORT (PAGE 26)
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PDF/X Creation

u
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v
There are many concepts and settings to consider in order to create a PDF/X compliant file.
The settings recommended by PDFX-ready represent a balance between the highest quality and
maximum reliabilty in order to achieve consistent
results. The following pages contain basic concepts and guidelines for high quality PDF/X creation for both QuarkXPress and Adobe InDesign.

ready recommends that images are prepared for
their intended effective resolution already in the
image editing software. This allows for best quality
regarding image sharpness. If needed, however,
downsampling can be re-activated. A good approximation for the needed image resolution can
be determined as followed:
line width (screening) x 2.54 x quality factor

Marks and Bleeds 1
Today all printer marks such as crop or registration marks are only used for visualization. In
order to interpret the geometric information correctly modern imposition tools rely on the boxes
that are encoded in the PDF file. The TrimBox,
for instance, defines the intended dimensions
of the finished page after trimming. PDF X-ready
follows the "less is more" principle and includes
only crop marks and page information in the PDF.

The quality factor is typically set to 1.5 for newspaper application and 2 for commercial printing. For
FM screening the resolution might be higher. As
a rule of thumb the resolution should be higher for
high-contrast images than for low-contrast images.

Compression 2
1. Downsampling
Downsampling determines the effective resolution to which the selected objects are recalculated.
The downsampling is triggered by the threshold
that indicates when to enable downsampling. In
PDFX-ready workflow V2 downsampling is
disabled by default. This is based on the fact that
high quality images might suffer from a inappropriate downsampling operation. Not downsampling
will result in large PDF files when images have
unnecessarily high affective resolutions. PDFX-

3. D
 ownsampling threshold
It makes no sense to downsample an image
from 304 ppi to 300 ppi. In order to trigger the
downsampling in a meaningful way, you can define
the resolution for which the downsampling will be
activated. For images above that threshold value, the
downsampling is applied. This avoids unnecessary
downsampling. If you plan to use downsampling, it
is recommended that you set the threshold number
to twice the value of the target resolution. In other
words if you want to achieve a image resolution of
300 ppi you should set the threshold value to 600

2. Downsampling method
There are different methods to perform the
downsampling. The best quality is typically
achieved by using bicubic downsampling.

w
ppi. This ensures that images with an effective resolution under 600 ppi won't be touched.
4. Compression
Not compressing images when creating a PDF
results in unnecessarily large file sizes. The
type of compression you use will depend the
quality requirements. PDF/X-4 offers two kinds
of lossless compression: ZIP and JPEG2000.
Conventional JPEG compression offers a range
of lossy compressions. Due to current performance issues using JPEG2000 (see box to the
right), PDFX-ready does not recommend using
JPEG2000, but instead recommends the use
of Automatic (JPEG) compression with image quality set to maximum. InDesign uses a
mechanism that analyzes the image content in
order to automatically select the optimal compression method for each image. Lower contrast
images typically will be compressed using the
JPEG algorithm while higher contrast images will
be compressed with the lossless ZIP method. In
the latter case technical type drawings and images such as screenshots benefit. ZIP compression won't cause a blurring appearance around
text (also known as a "halo") which will make it
more legible.

creation that is not dependent on a set output
profile. When the output profile is CMYK, all
placed RGB elements will be converted to
CMYK at the time of export. At the same time
the document profile will be used as the output
profile. QuarkXPress does not allow the use of
the document profile as the output intent. You
must be careful to use the correct destination
profile when exporting the PDF.
Threshold for font subsetting
This value determines if the font is subsetted
(only the effectively used characters in the document are embedded) or the entire font is embedded in the PDF. This function is only applicable
for PostScript Type 1 fonts. Currently OpenType
fonts are used more than Type 1 fonts. Since
OpenType fonts are always be subsetted, this
value is not that important anymore and the value should be set to 0% .

Colour settings for PDF export 3
PDFX-ready export settings for InDesign uses
the document colour profile as output intent.
This allows to use one generic setting for PDF

> NEXT: INDESIGN PDF-EXPORT(PAGE 28 AND 32)
OR QUARKXPRESS PDF-EXPORT (PAGE 30)

JPEG2000
This new image compression
method is supported in PDF version 1.5 and higher. It typically
outperforms traditional
JPEG
compression with higher image
quality and better compression
ratios. Tests performed with InDesign CS 5.5 (Version 7.5.1) support these findings. Acrobat X,
however, needs significant time
to display or scroll JPEG2000
compressed elements, or pages.
In addition, there are problems
when processing JPEG2000 elements in non-Adobe applications.
Therefore PDFX-ready does not
recommend JPEG2000 at this
time.

www.pdfx-ready.ch
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InDesign: Export as PDF/X CMYK
Using the conventional CMYK output, all ICCbased colour spaces as well as LAB encoded objects or RGB elements without a profile are prohibited. Only CMYK, Gray and spot colours are
allowed. Hence RGB elements must be converted to CMYK either before or during PDF export.
Profiles assigned (or tagged) to CMYK objects
will be ignored, and those elements must be already prepared for the destination colour space.

dation –

– Recommen

This CMYK workflow method is very well
established, and is considered to be a safe
and predictable way to prepare print-ready
data. The user is not relying on potentially
incorrect colour conversions to be done at
the print service provider.
Both PDFX-ready workflows V1.3 and V2 CMYK
use a CMYK based output schema.
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PDF/X Standard
The PDFX-ready V2 specification is based on
the PDF/X-4 standard. Currently only Adobe
CS products (as of CS 4 and later) provide true
PDF/X-4 support if the PDF/X-4 is exported directly from the application.
PDFX-ready V2 PDF Export settings for
InDesign
PDF versions 1.4 and above allow for objects
that cannot be defined in PostScript. In order to
ensure that these objects can retain their inherent qualities only the direct PDF export from InDesign can be used. Therefore no transparency
flattening will occur. In light of this, PDFX-ready
settings only cover direct PDF export settings
and will no longer offer Distiller settings.
PDFX-ready V2 CMYK PDF export settings are
mostly based on the PDFX-ready V1.3 PDF export settings. They differ from the V1.3 settings
in three important aspects, namely:
nn PDF/X Reference: PDF/X-4
nn Compatibility: PDF 1.4 or PDF 1.6 (InDesign
CS 5.5 or later)
nn Transparency: Live transparency

In both the PDFX-ready V1.3 and V2 workflows,
all print elements will be converted and exported
as CMYK. Elements already encoded as CMYK
will stay unchanged. While transparencies will
be flattened when exporting a PDF with the
PDFX
- ready V1.3 settings, they remain unflattened when using PDFX-ready V2 export settings. These settings are suitable for early binding as well as intermediate binding workflows
(see page 24).
Transparency Blend Space
PDFX-ready V2 CMYK does not allow ICC based
transparency blend spaces. CMYK blend spaces
which differ from the document colour space will
be changed to the document colour space when
creating the PDF. Since this procedure is not considered to be a colour conversion as such, this
mismatch will result in a warning message (see
on the right).
The modification of the transparency blending
space might lead to a different appearance, and
as such PDFX-ready recommends correcting the
data. If this is not possible, the result should be
visually checked for colour changes of the transparent objects.

Attention!
When PDF documents that are using RGB
based transparency blend spaces are placed in
InDesign, the application will not warn you. Instead it uses the active blend space. A warning
is only displayed during export if the transparency blending space of InDesign is set to RGB.
For this reason please check PDF files before
placing them with respect to the used transparency blending space. In Acrobat 9 Pro or later, you can identify the transparency blending
space at the bottom of the output preview. In
the flattener preview you can see the "PageLevel Transparency Blending Colour Space".
You can also alter the transparency blend space
here as well.
Top: correct result using ICC-based
RGB-Transparency Blend Space
Bottom: incorrect result using ICC-based
CMYK-Transparency Blend Space

> NEXT: PDF PREFLIGHT(PAGE 32)

www.pdfx-ready.ch
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QuarkXPress: Export as PDF/X CMYK
Using the conventional CMYK output method, all
ICC-based colour spaces as well as LAB encoded objects or RGB elements without a profile are
prohibited. Only CMYK, Gray and spot colours
are supported. Hence RGB elements must be
converted to CMYK either before or during PDF
export. Profiles assigned (or tagged) to CMYK objects will be ignored, and those elements must be
already prepared for the destination colour space.

dation –

– Recommen

This CMYK workflow method is very well
established, and is considered to be a safe
and predictable way to prepare print-ready
data. The user is not relying on potentially
incorrect colour conversions to be done at
the print service provider.
Both PDFX-ready workflows V1.3 and V2 CMYK
use a CMYK based output schema.
PDF/X Standard
The PDFX-ready V2 specification is based on
the PDF/X-4 standard. The current version of
QuarkXPress does not support a direct PDF/X-4
compliant export. Content wise, it provides for
compliance with all normative PDFX-ready V2
requirements. Therefore a regular PDF exported
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from QuarkXPress can be converted to comply
with the PDFX-ready V2 requirements by means
of Acrobat PDF preflight profiles (fix ups).
PDFX-ready V2 PDF export settings for
QuarkXPress
PDF versions 1.4 and above allow for objects that
cannot be defined in PostScript (such as native
transparencies). The current version of Quark
XPress still uses PostScript "under the hood" for
exporting PDF files. However by using a technical trick Quark is able to maintain transparency
operators in their PostScript export.
Although QuarkXpress does not explicitly create
PDF/X-4 files, the method below results in PDF
files that contain live transparencies that are capable of complying with PDF/X-4 requirements.
The main drawback of this method relates to
imported transparencies. QuarkXPress is unable
to interpret live transparencies which are part of
placed PDF or Illustrator documents. These objects will be flattened by QuarkXPress, which
might lead to output problems.

Therefore PDFX-ready recommends:
nn to save the PDF document as a PDF/X-1a document (no transparencies are allowed) before
importing in QuarkXPress and
nn to save Illustrator graphics in EPS format. This forces Adobe Illustrator to flatten
transparencies, which typically results in
higher quality documents compared to when
QuarkXPress flattens them. The transparency
effects will be preserved and can be edited
when the file is reopened in Illustrator.
The PDFX-ready V2 CMYK PDF export settings for QuarkXPress are mostly based on the
PDFX-ready V1.3 export settings. They differ

from the V1.3 settings in two important aspects,
namely:
nn Preflight: No standard, since there is no support for PDF/X-4 in QuarkXPress
nn Transparency: Native export

result in a flattened document, live-transparencies will be preserved when using the PDFXready V2 export settings. These export settings
are suitable for early binding and Intermediate
Binding workflows (see page 24).
Converting the QuarkXPress PDF
to PDF/X-4
Since the PDF created by QuarkXPress is not a
PDF/ X-4 file, it must be converted by means of
an additional Acrobat preflight "fix up" profile.
Convert the PDF to PDF/X-4 by using the
fix up profiles provided by PDFX-ready at
www.pdfxready.ch. If you are require an output condition that is not available in the existing profiles, you can easily modify an existing
profile to suit your needs. Please note that the
PDFX-ready fix up profiles don't do a colour
conversion. Hence all elements must be correctly prepared for the intended output condition.

When creating the PDF both by using PDFXready V1.3 or PDFX-ready V2 CMYK, all placed
elements will be converted to the CMYK profile
that is defined in the colour settings. Elements
that are already defined in CMYK stay the same.
While the export settings for PDFX-ready V1.3

www.pdfx-ready.ch

> NEXT: PDF PREFLIGHT(PAGE 32)
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Checking PDF: Preflight
Inspecting the final PDF file (Preflight) is an essential part of a PDF workflow. The settings provided by PDFX-ready for preparing and creating
print-ready PDF documents should be considered as guidelines that could be used and altered
when needed.
Basically, there are three stages of preflight:
Checking data and flagging problems while you
work on the layout (e.g. InDesign/QuarkXpress)
(page 19); after the PDF is created but before you
send the PDF document to the service provider;
and when output provider receives the PDF document for the final output.
The PDFX-ready preflight profiles run without
any error messages for a correctly generated
PDF files. You can download the profiles together with installation instructions at www.pdfxready.ch.
PDF Preflight in three steps
Step 1: Start the preflight panel. To find
“Preflight” go to “Advanced” or
“Print production” menu.

You can easily install the PDFX-ready preflight profiles - illustrated here for Adobe Acrobat 9
Pro – by importing them or by simply doing a Drag & Drop).
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Step 2: Analyzing the PDF/X-file. In this case the
profile “! PDFX-ready sheet fed Classic V1.3 (X-1a)”
is used.

Step 3: Results. The file has passed the
preflight as check by “! PDFX-ready sheet fed
Classic V1.3 (X-1a)”.
www.pdfx-ready.ch
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PDFX-READY V2, PAGE 36
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Why PDFX-ready V2?
The PDFX-ready V2 settings reflect the PDF/X-4
standard and the PDF/X-Plus specification prepared by the Ghent Workgroup (GWG). They
are a fundamental development of the existing
standards and in order to support state of the art
PDF workflows.
What are the key aspects of PDFX-ready V2
and why should you update?

Live Transparency

Process

Spot
When using PDFX-ready V2 live transparency will not be flattened anymore. Live transparency is
explicitly allowed in PDFX-ready V2. Retaining live transparency results in a number of advantages
when creating and processing PDF documents:
nn PDF creation is faster and more reliable, since there is no flattening process.
nn The resulting PDF documents have a smaller file size, since the flatting process often results in
complex compositions of objects.
nn The quality of the PDF files increases by means of:
–– Preserved text (which often will be converted to paths (outlines) or even to raster images.
–– Gradients will be encoded natively as smooth shades instead of images.
–– Vector objects will be preserved as vector and not be potentially converted to raster.
–– Artifacts (e.g. fine white lines), that might result by the flattening process can be avoided.
nn The rendering of the PDF document will be enhanced: Visualization errors such as fine lines that
disappear when zooming in are eliminated. This is also important for interactive PDFs which are
used for screen viewing (Internet, tablets or e-readers).
nn PDF files can be edited more easily, since the objects appear in the same way they are laid out
and designed (as opposed to being split into many pieces when flattened).
nn PDF files can be converted to different output conditions much easier. In addition, spot colours
can be fixed/modified when live transparency is retained. Once flattened, spot colours involved
in transparency cannot be altered.
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Archivability

Storing of
RGB images

PDF documents that comply with PDF/X-4 basically also comply also with PDF/A-2.
PDF/A-2 is an ISO standard for long-term archiving.
Using PDFX-ready V2 allows to prepare data
that is ready for tomorrows digital archives.

More stringent
font embedding
PDF/X-4 defines more stringent rules for embedding fonts, single characters and glyphs.
This helps to reduce potential problems when
processing PDFs in a workflow system (for instance at the imposition stage).

Layers in PDF
PDF/X-4 allows for layers. These optional content groups permit the dissemination of multilanguage PDF documents as well as non printing elements such as dielines.

For PDFX-ready V2 we recommend a fundamental change for storing images. Don’t
convert images to CMYK already in Photoshop
– keep them in RGB and perform the CMYK
conversion in the layout application.
This keeps your images ready for the cross media future. Nevertheless you can create PDFs
with predictable results for printing. In case
you have to create a PDF for ePublishing all image data are in the appropriate color space.
All PDFX-ready settings and export presets are
optimize for this requirement (see pages 13
and 28+30).

Since the concept of layers used in PDF/X-4
is relatively new, there is limited support both
for PDF creation and processing at the present
time.

16 Bit, JPEG2000
PDF/X-4 allows image data to be saved with
16 bits and supports the more advanced
JPEG2000 compression.
Using 16 bits per channel allows for a better conversion from RGB to CMYK while
JPEG2000 will reduce the file size by achieving a similar image quality. However, both
technologies are currently not well supported
in layout applications and workflow tools.
PDFX-ready recommends therefore to currently renounce using 16 bit images and
JPEG2000.

www.pdfx-ready.ch

> NEXT:
PDFX-READY QUALITY STANDARD, PAGE 36
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The PDFX-ready Quality Standard I
The following pages provide an overview of the inspections that are part of the PDFX-ready preflight
profiles. They inform you about the minimum requirements each PDF document has to comply with
in order to meet PDF/X criteria. In addition they show the differences between the V1.3 and V2 workflows. The symbols represent the error type ranging from an error (cross) to a warning (triangle) to an
information (blue circle).
Can I adapt the PDF/X-ready
preflight profiles to suit my
needs?
Sure thing! These profiles represent a starting point. In all cases
it is allowed to add more stringent
requirements to the profile, however, it is not advisable to reduce
the requirements. Most people
will adjust the profiles to reflect
“house standards” by increasing
image resolution requirements or
other such adjustments.
It is not recommended to “loosen”
the criteria for existing checks, or
to delete them altogether. This
could lead to significant problems
such as a service provider who rejects your PDF documents.

How do I assess the preflight
results?
Preflight information is divided
into three groups:
“Errors” refer to critical problems, which might lead to reduced
quality and potential problems at a
later processing stage.
“Warnings” alert you to potential
problem findings on an individual
basis. The user has to review the
warning to interpret if the concern
is really a problem or not.
“Information” is a message that
provides information about the
file/process that is not directly related to the final print product.

PDF Version
V1.3

PDF 1.3 (The PDF is damaged and needs repair)
V2

PDF 1.6 (The PDF is damaged and needs repair)

PDF/X Compliance
V1.3

PDF/X-1a
V2

PDF/X-4

V1.3

V2

Unknown operator in page description

V1.3

V2

Annotations

V1.3

V2

CropBox not equal to MediaBox

V1.3

V2

Created with PDFWriter or PDF2GO

Pages, Document

V1.3

Object is outside MediaBox

V1.3

V2

Page size or page orientation is different from page to page

V1.3

V2

Document is trapped
Overfilling (trapping) is not equal to Overprinting! The latter one
must be done by the data creator and will be cheched by the PDFXready preflight profiles. The print shop is responsible for trapping a
file (by means of spreads and chokes) since it requires knowledge
of the misregistration tolerance for which the trapping is required.
PDF/X files use a “Trapped Key” that defines if a document has
been trapped or not in order to avoid an additional trapping. PDFXready informs you when the Trapped Key is set to “True”.

A PDF that results in “errors”
is not in conformance with the
PDFX-ready specs.

Only for newspaper printing:
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V1.3

V2

Number of pages is unequal 1

V1.3

V2

Empty Pages (“Information” for sheet- and web offset printing)

Images
V1.3

Run length encoding is used

V1.3

Uncompressed images
V2

ppi vs. dpi

Resolution of an image only page is less than 300 ppi
(warning for values between 300 and 450 ppi)
If a page is made up only by one (1) image and no other print elements it
is very likely that Photoshop has been used as the “layout application” or
that is a scanned page. Since such pages might contain text and vectors
there must be more stringent requirements for the image resolution.

PDFX-ready uses ppi (pixel per
inch) when referring to the image
resolution. Often this is confused
with dpi (dots per inch). Generally, dpi refers to the the number
of pixels (1 bit) of output devices,
whereas ppi typically refers to the
intrinsic pixel elements (24 or 32
bits) of an image.

Sheetfed offset:

< 200 ppi

200–299 ppi

> 750 ppi

< 900 ppi

900–1200 ppi

> 3600 ppi

< 200 ppi

200–299 ppi

> 750 ppi

< 900 ppi

900–1200 ppi

> 3600 ppi

< 150 ppi

150–225 ppi

> 750 ppi

< 550 ppi

550–800 ppi

> 3600 ppi

pixel image

line work

Web offset:

pixel image

line work

Newspaper printing:

pixel image

line work

www.pdfx-ready.ch
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The PDFX-ready Quality Standard II
Total ink coverage
V1.3

V2

Registration colour used

V1.3

V2

Object uses 400% ink (C + M + Y + K = 400%)

V1.3

V2

Total ink coverage for rich black is too high
Object = text
K > 85%
C+M+Y+K≥

280%

280%

220%

In some cases black text set as 100 K might be converted by ICC colour
management and could lead to problematic CMYK tone values for that text
(e.g. 78 C/68 M/58 Y/94 K). This check will inspect and identify this problem which usually indicates wrong colour management settings.

V1.3

V2

Effective ink coverage is above…

		

320%

290%

230%

When checking the ink coverage, PDFX-ready recommends to include not
only single vector objects but also their interactions by means of blend
modes, transparency and overprinting, as is inspected by this custom
check. In addition to the preflight check a visual check is recommended to
judge the ink coverage by using the output preview. This is advisable since
this check only indicates the problem on a page and not an object level.

For this reasons PDFX-ready continues to use the custom checks for ink
coverage for stroke and fill of objects. This check does not detect images
or overprinting elements but lists all findings individually. An additional
difference is the sample size: While the check “ink coverage of stroke and
fill” finds objects of all sizes (including thin lines to be used in logos), “effective ink coverage” checks the objects by means of a minimum sample
area defined by 15 x 15 mm. Print problems are not likely for small areas
comprising a high ink coverage.
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Fonts
V1.3

V2

Courier inside TrimBox

V2

PDF/X-4 (to be used for PDFX-ready V2)
has additional font restrictions:
inconsistent font widths and usage of .notdef Glyph are forbidden.

Misregistration, Overprinting
V1.3

V2

White text is not set to knock out

V1.3

V2

White vector is not set to knock out

V1.3

V2

Gray object is not set to knock out

V2

Gray line thinner that 2 pt. is not set to overprint
Gray text smaller than 12 pt is not set to overprint
Gray line thinner than 2 pt is set to overprint but knocks out CMYK
Gray text smaller than 12 pt overprints but knocks out CMYK
Grey objects might be set to overprint or not. However, according to the
PDF specification gray objects can not overprint CMYK objects and therefore always knock out these objects. In order to enable overprinting the
objects must be encoded by either CMYK black or separation black.

V1.3

V2

Text smaller than 5 pt

V1.3

V2

Text smaller than 8 pt uses more than 1 colorant (Newspaper 10 pt)

V1.3

V2

Hairline (< 0.25 pt) uses at least two colorants

V1.3

V2

Line width lessr than 0.125 pt (hairline)

V1.3

V2

Black text knocks out and is smaller than 12 pt

V2

Black line thinner than 2 pt is not set to overprint

V1.3

V2

Identical appearance of two or more spot colours

V1.3

V2

Using more than 3 spot colours (0 for newspaper and web offset)

V1.3

V2

Spot colour is used

V1.3

V2

Appearance of spot colour inconsistent

V2

The GWG Spec (used by PDFX-ready V2)
requires additional spot colour properties:
spot colours having different names but identical alternate colour
values and spot colours with inconsistent appearance are not allowed.

Spot colours

www.pdfx-ready.ch
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> CREATOR
OUTPUT

> CMYK > V1.3 > PREFLIGHT > QUALITY STANDARD
V2

The PDFX-ready Quality Standard III
Colour Space
Object-type

Text/Vector
(Colour)

A

Vector elements / technical tones

Transparency Blending
Colour Space
The transparency blending
space will be checked by the
PDFX-ready preflight profiles. It
must be either set to None or
DeviceCMYK or must be identical to the output intent to avoid
unwanted colour conversions.

V1.3

V2

CMYK-Workflow

Allowed colour spaces
DeviceCMYK
The tone values used within the objects are characterized by the PDF/X
output intent.

dation –

Disallowed colour spaces
DeviceRGB (prohibited)
ICC-based CMYK
This can lead to unpredictable colour
changes and print related problems
such as contamination, composed
black (4C), registration problems and
other issues.

ICC-based RGB, Lab
The resulting colour transformation won’t allow for “pure”
CMYK colours (.e.g 4C black).

Text/Vector
(Gray)

A

DeviceGray
The tone values used within the objects are characterized by the PDF/X
output intent.

DeviceCMYK
The tone values used within the images are characterized by the PDF/X
output intent.

Raster images

Images
(Colour)

ICC-based Gray
This will lead to an unwanted 4C
separation.

DeviceRGB (prohibited)
ICC-based CMYK
This might lead to unwanted reseparation including a different black
generation.

ICC-based RGB, Lab
These images must be converted to
CMYK before or during the export in a
controlled fashion.

Images
(Gray)
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– Recommen

DeviceGray
The tone values used within the images are characterized by the PDF/X
output intent.

ICC-based Gray
This will lead to an unwanted 4C
separation.

> CREATOR
OUTPUT

> CMYK > V1.3 > PREFLIGHT > OUTPUT INTENT
V2

The PDFX-ready Output Intent Rules
Any PDF/X file contains an Output-Intent that
defines for which printing condition the document is prepared. The Output Intent indicates
the printer (e.g. a newspaper printer) that the
print elements have been prepared correctly for
newspaper printing. The Output Intent therefore
specifically characterizes the CMYK tone values
within the PDF document.
The PDF/X-ready preflight profiles contain sophisticated rules to check which output intent
might be more or less appropriate for the intended purpose. These rules, in part, are discussed in
the section that follows.
Checking the Output Intent for plausibility
is a key aspect of inspecting a PDF/X file to
determine if its print ready or not.
The entire set of rules can be downloaded at
www.pdfx-ready.ch/index.php?show=514

Sheetfed offset (Selection)

ISOcoated_v2_eci.icc
ISOcoated_v2_eci_300.icc
PSO Uncoated ISO12647 (ECI)
ISOuncoatedyellowish.icc
PSO_Coated_300_NPscreen_ISO12647_eci.icc
PSO_Coated_NPscreen_ISO12647_eci.icc
PSO_Uncoated_NPscreen_ISO12647_eci.icc

!!! Output Intent for sheedfed offset (legacy profile)
EuropeISOCoatedFOGRA27.icc
CoatedFOGRA27.icc
ISOcoated.icc
ISOuncoated.icc
The ICC profile in this output intent is based on an
old color standard. There might be color deviations
in printing. PDFX-ready recommends the latest ICC
profiles from ECI (www.eci.org). More information on
color management and output intents can be found on
www.pdfx-ready.ch or www.gwg.org.

Web offset (Selection)

PSO_MFC_Paper_eci.icc
PSO_SNP_Paper_eci.icc
SC_paper_eci.icc
ISOcoated_v2_eci_300.icc
PSO_Coated_300_NPscreen_ISO12647_eci.icc
PSO LWC Improved (ECI)
PSO LWC Standard (ECI)

For all output conditions
!!! Output Intent not
recommended (legacy profile)
EuroscaleCoatedV2.icc, EuroscaleUncoatedV2.
icc, USSheetfedCoated.icc, USSheetfedUncoated.icc, EurostandardCoated15v1.icc,
USWebCoatedSWOP.icc, USWebUncoated.icc
The ICC profile in this output intent is based on an old
color standard. PDFX-ready recommends the latest
ICC profiles from ECI (www.eci.org).

!!! Output Intent for web
offset printing (legacy profile)
ISOwebcoated.icc
The ICC profile in this output intent is based on an
old colour standard. There might be colour deviations
in printing. PDFX-ready recommends the latest ICC
profiles from ECI (www.eci.org).

Newspaper printing (Selection)
ISOnewspaper26v4.icc
ISOnewspaper26v4_gr.icc

!!! Output Intent not suitable for
printing data (generic ICC profile)
QuarkGenericCMYK.icc, QuarkGenericGray.icc, QuarkXPressLegacyCMYK.icc, Generic CMYK Profile.icc,
Generic Gray Profile.icc, GWG_GenericCMYK.icc
Most probably wrong color settings in the layout application have been used to create this PDF.
PDFX-ready recommends the latest ICC profiles from ECI
(www.eci.org).

www.pdfx-ready.ch
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PDFX-READY OUTPUT INTENT RULES, PAGE 42
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> OUTPUT > CMYK > V1.3 > OUTPUT CONDITIONS
V2

How to use the PDF/X Output Intent
One of the key concepts of PDF/X is the Output
Intent (output condition). The Output Intent characterizes the device dependent colour values
of a PDF. This allows the receiver to identify if
the PDF has been prepared for offset printing or
newspaper.
The Output Intent unambiguously characterizes
the CMYK tone values within a PDF/X document. It should be noted that the Output
Intent does not trigger any colour transformations. In contrast, device independent colour
definitions often lead to automatic colour transformations. Choosing the correct Output Intent
is important so that the print service provider can
verify that the actual printing condition matches
the output conditions of the PDF.

Currently, the usage of the profiles provided by
the ECI (European Colour Initiative) – namely
ISO Coated v2 300%, PSO Uncoated ISO12647
(ECI), PSO LWC Improved (ECI) and ISO Newspaper 26v4 provided by WAN-IFRA – are recommended to be used in an Output Intent. Other
profiles will likely result in preflight messages
and indicate that the PDF creator has not followed the recommendation described in the
PDFX-ready recepies.
The PDFX-ready rules described on page 41 help
to identify the correct Output Intent and how to
check if a supplied profile can be used or not.
How should a print service provider react to
inappropriate Output Intent?

File:

actual output

X/1-a
X/4 CMYK
Output Intent
ISO Coated
v2 300% (ECI)

Output 1:1

Sheetfed
offset coated

X/1-a
X/4 CMYK
Output Intent
ISO Coated
v2 300% (ECI)

Colour
conversion
required

Appropriate action: Convert the entire document using dedicated DeviceLink profiles (to preserve primary colours or black
text) or a similar method. If needed create a new proof.
Appropriate action: Contact data creator and
request properly separated data.
Inappropriate action:
Ignore Output Intent, output PDF 1:1
Inappropriate action: Conversion of the entire document
using ICC profiles without maintaining black and primary
colours (pure colours including black text will be polluted).
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Sheetfed offset
coated
using NP screen;
uncoated or
newspaper
printing

actual output

File:

Fogra characterization data

X/1-a
X/4 CMYK
FOGRA39
characterisation

Output Intent
ISO Coated v2
BasICColor, Adobe

Sheetfed
offset coated

No colour conversion required, since the Output Intent is based on
the same characterisation data than the actual printing condition.
Inappropriate action: Conversion of the entire document
using ICC profiles without maintaining black and primary
colours (pure colours including black text will be polluted).

X/1-a
X/4 CMYK
FOGRA27
characterisation

Output Intent
ISO Coated v1

Fogra provides characterization
data for printing conditions that
are representative for important
market segments. These are numbered starting from FOGRA1 and
ranging currently to FOGRA50.
E.g. FOGRA39 defines offset
printing on coated stock. Based
on this characterization data set,
ICC-profiles can be built. As described, they are virtually identical
for the printing direction (CMYK to
CIELAB) but might be significantly different with respect to gamut
mapping and black separation. As
long as an ICC profile is used that
fits to the pertinent characterization data set, no colour conversions are needed.
You can find an overview of the
current Fogra data set at
www.fogra.org/en/fogra
standardization/fogracharacterizationdata/a-icc-en.html

Sheetfed
offset coated

ApAppropriate action: Convert the entire document using
dedicated DeviceLink profiles (to preserve primary colours or
black text) or a similar method. If needed create a new proof.
Appropriate action: Output PDF 1:1 (visual match
between proof and print will be compromised).
Appropriate action: Contact data creator and
request properly separated data.
Inappropriate action: Conversion of the entire document
using ICC profiles without maintaining black and primary
colours (pure colours including black text will be polluted).

X/1-a
X/4 CMYK
Colour
conversion
required

Output Intent
QuarkGeneric,
SWOP...

Sheetfed
offset coated

Appropriate action: Contact data creator and
request properly separated data.
Possible action: Ignore Output Intent, output data 1:1, but only
after a colour check, customer agreement and additional
approval (by means of a contract proof).
Inappropriate action: Conversion of the entire document
using ICC profiles without maintaining black and primary
colours (pure colours including black text will be polluted).

> NEXT:
OPTIMIZING PDF, PAGE 44
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> OUTPUT > CMYK > V2 > OUTPUT

Modify PDF colours: why and how?
What are the reasons for a print service provider
to convert colours?
nn Change of the Output Intent: The main
reason for changing an Output Intent was described on the last two pages – colours defined by the PDF won’t match the actual printing condition. In order to achieve the desired
appearance the colours must be converted. In
some cases, even when the Output Intent and
actual printing condition do match, there may
be a need for a conversion:
nn Modify total ink coverage: Reducing the
total ink coverage (tone value sum), lets say
from 330% to 280% or even less, might help
to increase print stability. Typically there is less
potential for blocking and faster drying.
nn Ink Saving: In particular for longer run lengths
an ink saving conversion might help to reduce
ink costs. Using a separation that is tailored
to the pertinent printing condition can help to
improve print quality and increase process stability.

From ISO Coated V2 …

I am a text
Fills, text or drop shadows defined as 100% black

0%
0%
0%
80%

Cyan
Magenta
Yellow
Black

50%
10%
0%
0%

Cyan
Magenta
Yellow
Black

While the change of the Output Intent can easily be done by the data creator, modifications
such as total ink coverage reduction or ink saving
algorithms should be done by the print service
provider.
Conventional ICC based approaches, such as the
one used by Adobe Photoshop, are not capable
to perform colour conversions for PDF documents that contain images, text and vectors.
State of the colour conversion tools are required
to perform such CMYK-to-CMYK conversions,
as they will use so called DeviceLink profiles
for this task. What is so special about DeviceLink profiles, and how do they work?

15%
100%
80%
10%
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Cyan
Magenta
Yellow
Black

… to ISO Newspaper.

ICC conventional

45% Cyan
33% Magenta
33% Yellow
87% Black

DeviceLink based

0% Cyan
0% Magenta
0% Yellow
100% Black

Converting colours using ICC colour profiles results in colorimetrically correct colours, but the separations are not appropriate for printing. A properly constructed DeviceLink profile, however, maintains
the pure colours (e.g. Black separation).

ICC conventional

20% Cyan
11% Magenta
12% Yellow
64% Black

DeviceLink based

0% Cyan
0% Magenta
0% Yellow
65% Black

Here the DeviceLink profile is created in order to modify the tone values) – by preserving the colour
channels.

ICC conventional

38% Cyan
10% Magenta
2% Yellow
6% Black

DeviceLink based

37% Cyan
6% Magenta
0% Yellow
0% Black

With ICC based colour conversion “pure” colours are often polluted with other separations in the
range from 1 to 9%. This is particularly problematic for skin tones.

ICC conventional

DeviceLink based

4% Cyan
93% Magenta
58% Yellow
18% Black
10% Cyan
100% Magenta
74% Yellow
7% Black

Also for CMYK source colours, which are typical for images, DeviceLink conversion might help to
increase the separation quality. This also leads to smoother gradients.

> NEXT:
PDF/X-4 PROCESSING, PAGE 46
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> OUTPUT > CMYK > V2 > OUTPUT

PDFX-ready V2 Processing
PDF/X-1a, which is based on PDF 1.3, is a data
format that can be converted to PostScript Level-3 without any loss. On the other hand PostScript can be converted to PDF 1.3 without any
problem. All PDF workflow systems, that use
a “Configurable PostScript Interpreter” (CPSI),
convert the PDF to PostScript before processing
at the RIP. Processing PDF/X-1a (or PDF 1.3)
files using a CPSI RIP is eaily possible.
Since the introduction of live transparency in PDF
files, starting with PDF version 1.4, more and
more problems were identified when processing
PDF documents with PostScript based (CPSI)
RIPs. The biggest issue is the correct rendering
of objects using live transparency. Since PostScript cannot understand or process live transparency, the CPSI based systems must simulate
the visual appearance of transparency as closely
as possible. This is done using a process called
“Flattening” or “Transparency Reduction”. Only
workflow systems with a native PDF renderer
can handle live transparency without any flattening. Native PDF RIPS allow the creation of high
quality output that are needed for the imaging
process, without intermediate steps such
as flattening. If a newer RIP with native PDF
support is used, splitting images into many fragments or converting parts of a text to outlines or
even bitmap as was done with flattening is no
longer happening.
PDF/X-4 is based on Adobe PDF version 1.6 and
allows live transparency, layers (optional content), 16 bit images and state of the art compression .
As of PDF version 1.7 the page
description format became the
ISO standard ISO 32000 in 2008.
Future PDF/X standards will
therefore refer to ISO 32000.
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Long story short: a native PDF rendering engine is needed to correctly process and output PDF/X-4 files. This technology is certainly
backwards compatible and therefore is also able
to render PDF 1.3 files. Using this technology
allows to predictably and consistently render all
kinds of PDF files.

Some notes for transitioning to PDF/X-4:
nn PDF-Creation: A PDF/X-4 file containing live
transparency requires the direct PDF exporting to PDF. PDFX-ready provides updated export settings for typical applications that offer
a PDF export.
nn Proofing: A contract proof made from a
PDF/X-4 file using live transparency requires
a native PDF rendering engine. If not, the
proofing system is forced to flatten the transparency, which might lead to reproduction
problems. All major proofing manufacturers
provide native PDF renderers for their systems. It is important that this functionality is
enabled and that the PDF is not output by using the “print menu”.
nn Trapping: Object level trapping within a PDF
file requires that the trapping software has access to the effective colour of each object. In
case of ltransparent objects this not possible,
since the final colour value depends on the objects underneath. Typical trapping software is
not able to perform such a calculation. Some
trapping solutions therefore flatten the PDF
before starting the trapping process. This process is not advisable since known flattening
issues may result. PDFX-ready recommends
preserving live transparency while trapping. Objects that are part of a transparency
group will be trapped as usual. The transparency property of the transparency goup will
also be applied to the created traps.

nn Colour conversion: Changing colour values
of individual objects might lead to problems
since colour conversion tools don’t respect
the effective colour created by the transparency effect. Especially colour transformations
might result in significant colour differences.
The reason for this is the colour transformation processed each object separately. Blending objects by means of transparency, however, represents the interaction of all objects
involved.
Furthermore it is possible that a transparency
effect would result in a heavy darkening of the
object colour. For example, even if an image
has no part with more than 300% ink coverage, it may end up with ink coverage values of
about 350%. In such a case there are currently
three possible solutions:

nn Imposition in a layout application: As with
PDF/X-1a-files, the Output Intent of the placed
PDF pages must match the document colour
space. Currently all layout applications ignore
the output intent and perform only a transformation of the RGB to CMYK at the PDF export.
A page layout program that uses conventional
ICC colour management is not the right tool
to perform page level colour transformations.
Since there is likely no warning when placed
objects have mismatched Output Intents, it
is advised to check the documents manually
before placing.
nn Knock-Out and Overprint: The same rules
apply to PDF/X-4 files as for PDF/X-1a. Overprint settings should he honoured, unless
there are important reasons not to do so.
Such reasons might be:

nn Use a different transparency effect that will
result in a similar appearance.

nn the presence of white text with enabled
overprinting

nn Flatten the relevant page.
nn Apply colour transformation after rendering
of the document. The downside to this is
that placed control wedges will also be converted, which is typically to be avoided.

nn the presence of opaque spot colours that
could contaminate overprinting blacks
nn the presence of metallic or neon spot colours
It is important that overprinting will be evaluated for visual inspection and proofing. Working
with live transparency clearly has some benefits in this regard, since display of transparency is independent from overprint simulation.
Flattened PDF files, displayed without the
overprint simulation, will often be displayed
incorrectly.

www.pdfx-ready.ch
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PDF/X-4 PROCESS CONVERSION WORKFLOWS, PAGE 48
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> OUTPUT > CMYK > V2 > OUTPUT

PDFX-ready V2-Process conversion workflows
In order to properly process and output PDF/X-4
files compliant to PDFX-ready V2 you need:
nn either a RIP with native PDF rendering (such
as the Adobe PDF Print Engine or Harlequin 9)
nn or a mechanism to perform flattening followed by a required colour conversion.

PDFX-ready recommends to use a RIP with native PDF rendering. Only by using such a technology can you ensure a true end-to-end native
PDF workflow which fully supports the PDF/X-4
advantages.
How do practical and reliable processing
strategies for PDFX-ready V2 CMYK look like
when color conversion is required? 

PDFX-ready V2 CMYK…

DeviceLink
conversion

PDF/X-4
all page
elements
in CMYK

PDF/X-4
all page
elements
in CMYK

DeviceLink conversion in combination with complex transparency effects (in particular when using
different blend modes) might change the final appearance quite significantly. Although this conversion is possible, users should be cautious when using it. It is highly recommended to create a contract proof or a validation print to inspect the conversion result visually.

Flattening

PDF/X-4
all page
elements
in CMYK

PDF/X-1a
all page
elements
in CMYK

DeviceLink
Conversion

PDF/X-1a
all page
elements
in CMYK

You can avoid the above problem when converting a PDF/X-4 into PDF/X-1a before applying the
DeviceLink conversion.

DeviceLink module

Trapping module

PDF/X-4
all page
elements
in CMYK

Adobe
PDF Print
Engine

Raster
proof

CTP

The best way is to simultaneously apply trapping, colour conversion, graphics handling, font processing,
and transparency processing of the entire job in a single, integrated operation (e.g. by using the Adobe PDF
Print Engine). This allows for predictable results not only for plate imaging, but also for soft and hard proofing. Integrated workflows such as this are currently only supported by a few workflow or printing systems.
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PDFX-ready certification
Using the PDFX-ready test pages each user can
validate the PDF/X compliancy of his workflow
and its tools. PDFX-ready offers multiple certificates for each step in the workflow.

Output certification

Creator certification

For the certification a supplier shall use personalized test pages (four A4 pages each containing 8
test patches, one page has spot colour) displaying the name of the supplier. A personalized test
file can be ordered from the PDFX-ready secretary (info@pdfx-ready.ch). Please indicate which
of the three test files (Offset, Digital or Proof)
you need.

With the creator
certificate a supplier can proof
CREATOR
that he is able to
PDF/X-1a PDF/X-4
create valid PDF/
X-1a and PDF/X-4
files from the same layout document according
to the recommendations of PDFX-ready.
For this certification a supplier must deliver a
PDF/X-1a and a PDF/X-4 file as well as a questionnaire with a description of the workflow for
creating the files. These requirements must be
met:
nn Size A4 portrait with a bleed of 3 mm.
nn Surface or image in the bleed.
nn Image (resolution and colour must match the
Output Intent).
nn Black and white texts on coloured background.
nn Transparency (minimum requirement is a drop
shadow).
nn The text contains information about the creator (company name, address, phone number,
e-mail, responsible operator).
nn Export of the same layout document into a
PDF/X-1a and a PDF/X-4 CMYK according the
PDFX-ready recommendations.
nn The PDF/X-1a file shall be compliant to PDFXready preflight V1.3 and the PDF/X-4 file shall
be compliant to PDFX-ready preflight V2.x. No
preflight errors are accepted.

With the output certificate a supplier can proof
that he is able to correctly output a valid PDF/X
file using his workflow and his operators.

Output Offset certification
With this certificate a offset
print supplier can
proof that he is
PDF/X-4
Offset
able to process
and output a valid
PDF/X-4 file using his prepress workflow.
nn Process the four personalized test pages (including spot colour) in the prepress workflow
(including imposition) like any regular file delivered for printing.
nn The use of a RIP with native PDF rendering is
recommended. Otherwise transparency flattening is necessary.
nn Imaging of the plates.
nn Printing on offset press (sheetfed or web).
nn Cutting to size A4 (respecting the irregular
bleed values on each side!)
nn Send 10 cutted prints of each page together with the filled (and legally signed)
questionnaire to the PDFX-ready secretary:
PDFX-ready, CH-9014 St. Gallen, Switzerland.

www.pdfx-ready.ch
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PDFX-ready Expert certification

Output Digital certification
With this certificate a digital print
supplier can proof
that he is able to
process and print
a valid PDF/X-4

Employees of member companies which have
successfully passed the PDFX-ready Creator or
one of the PDFX-ready Output certifications can
proof their PDF/X knowledge in a web based online test.

file using his workflow.
nn Doublesided printing of the four personalized
test pages (including spot colour) on a digital
printing system.
nn Cutting to size A4 (respecting the irregular
bleed values on each side!)
nn Send 10 cutted samples together with the
filled (and legally signed) questionnaire to the
PDFX-ready secretary: PDFX-ready, CH-9014
St. Gallen, Switzerland.

With the PDFXready Expert certificate an operaCERTIFIED EXPERT
tor proofs that he
PDF/X-1a
PDF/X-4
posses the theoretical knowledge
regarding the creation and output of PDF/X files
according to the PDFX-ready recommendations.

PDF/X-4

Digital

Cost
Output Proof certification

PDF/X-4

Proof

With this certificate a proof supplier can proof
that he is able
to output a valid
PDF/X-4 file on

his proofing system.
nn Output of three copies the four personalized
test pages (including spot colour) on a digital
proofing system (proof RIP and printer) like
regular PDF/X pages.
nn The proof must include a status line according to ISO 12647-7 (proofer name, colour, substrate, simulated printing condition, ICC profile, date and time).
nn Indication of the final printed size using cutting
marks or a visible frame or masking of bleed
using the TrimBox information of the PDF/X
file (irregular bleed values on each side!).
nn Send three sets of the four pages together
with the filled (and legally signed) questionnaire to the PDFX-ready secretary:
PDFX-ready, CH-9014 St. Gallen, Switzerland.
Attention: This is not a colour quality test
but only a check for PDF/X compliancy. No
need to use special paper for this test.

The following certifications which are valid for
two years are included in the membership fee:
nn 1 Creator certification
nn 1 Output certification (Offset or Proof or Digital)
nn 3 Expert certification (1 for individual members)
Additional certifications (also untimely) require
an additional fee:
nn Creator certification: CHF 100.00
nn Output certification: CHF 100.00
nn Expert certification: CHF 50.00

PDFX-ready and
FograCert PDF/X
Fogra is offering in Germany the certifications
FograCert PDF/X Creation and FograCert PDF/X
Output.
Regarding requirements and examination those
are identical to the PDFX-ready Creator and Output certifications.
It’s up to you if you prefer PDFX-ready or Fogra
as primary examiner and issuer of your certificate.
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The PDFX-ready association
PDFX-ready was founded in 2005 by a representative selection of the graphic arts industry
(see box on the right). This swiss initiative is aiming to increase the data exchange of PDF documents according to the standard ISO 15930 (better known as PDF/X). PDF/X provides means for
efficient and predicable graphic arts workflows.
The PDFX-ready certification
A key aspect of this initiative is the PDFX-ready
certification. This renowned certificate confirms
that both individuals and companies can reliably
create (creator) or process and output (output)
PDF/X compliant files. Being certified proves you
are PDF/X workflow savvy. These certifications
are done in cooperation with Fogra (graphic arts
research association) and ugra (swiss centre of
competence for media and printing technology).
These certifications can also be useful for print
buyers, since they can benefit from increased
workflow efficiency and data-integrity of their
suppliers.

The PDFX-ready organisation
PDFX-ready is made up of four different working
groups.
Creating and updating PDF/X export settings,
preflight profiles and recipes is the main task of
the technical working group. The results generated by this working group are available at www.
pdfx-ready.ch.
The certification working group works in concert
with the Ghent Workgroup (GWG) to create test
pages which are used for output certification.
It also provides online test questions that allow
employees of certified companies to become
PDFX-ready certified experts. The group has
also developed the requirements for the Creator
certification.
The marketing working group is in charge of the
internal and external communication efforts for
PDFX-ready.

Partners
Partners of PDFX-ready are:
A&F Computersysteme AG
Adobe Systems (Schweiz) GmbH
Agfa Graphics Switzerland AG
callas software GmbH
Digipress GmbH
dpi Publishing Service AG
Druckmarkt
Druckmarkt Schweiz
Fogra Forschungs
gesellschaft Druck e. V.
Impressed GmbH
iware sa
Mediaforum (dpi
Publishing Service AG)
PBU Beratungs AG
PrePress-Consulting
PrintOnline AG
Publicitas AG
PubliCollege GmbH
Swissprinters AG
Ugra
Verband Druck & Medientechnik
Viscom
Viscom print & communication
VSD / IGS

Last but not least, the education working group
coordinates trainings and was also heavily involved in creating this guideline.
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